
Thai Support Plug-in 7.1  ”À√—∫ Mac OS X

‚ª√·°√¡∑’Ë„™âß“π‰¥â ”À√—∫‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
- Adobe Illustrator 10.0.3,  CS-11.0, CS2-12.0.1
- Adobe InDesign 2.0.2, CS-3.0.1, CS2-4.0.2, CS3-5.0
- Adobe Photoshop 7.0.1, CS-8.0, CS2-9.0
- Microsoft Word 10.1.5
- Microsoft Excel 10.1.5

‚ª√·°√¡∑’Ë„™âß“π‰¥â ”À√—∫‡§√◊ËÕß∑’Ë„™â™‘ª Intel
- Adobe InDesign 2.0.2, CS-3.0.1, CS2-4.0.2, CS3-5.0
- Adobe Illustrator 10.0.3
- Adobe Photoshop 7.0.1 (‡©æ“–‡§√◊ËÕß∑’Ëµ‘¥µ—Èß Mac OS X 10.4.x)

§«“¡µâÕß°“√¢Õß√–∫∫
- ‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.3.9 À√◊Õ Ÿß°«à“  ”À√—∫‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
- ‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.4.0 À√◊Õ Ÿß°«à“  ”À√—∫‡§√◊ËÕß∑’Ë„™â™‘ª Intel

°“√ª√—∫ª√ÿß·°â‰¢„π‡«Õ√å™—Ëππ’È
25 ¡‘∂ÿπ“¬π 2551
‡«Õ√å™—Ëπ 7.1

- ·°â‰¢ Microsoft Word 10.1.5 ·⋲– Microsoft Excel 10.1.5 „Àâ„™âß“π‰¥â°—∫‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x
∫π‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
- ·°â‰¢ Adobe Illustrator CS-10.0 ·⋲– CS2-12.0.1 „Àâ„™âß“π‰¥â°—∫‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x
∫π‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
- ·°â‰¢ Adobe Photoshop CS-8.0 ·⋲– CS2-9.0 „Àâ„™âß“π‰¥â°—∫‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x
∫π‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
- ·°â‰¢ Adobe InDesign 2.0.2 „Àâ„™âß“π‰¥â°—∫‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x ∑—Èß‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
·⋲–™‘ª Intel
- ·°â‰¢ Adobe Illustrator 10.0.3 „Àâ„™âß“π‰¥â°—∫‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x ∑—Èß‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC
·⋲–™‘ª Intel



À¡“¬‡Àµÿ ”À√—∫°“√„™â TSP 7.1 ∫π‡§√◊ËÕß∑’Ë„™â™‘ª Intel
- Adobe InDesign ∑—Èß‡«Õ√å™—Ëπ 2.0.2, CS, CS2 ·⋲– CS3  “¡“√∂„™âß“π¿“…“‰∑¬‰¥âÕ¬à“ß ¡∫Ÿ√≥å
- Adobe Illustrator 10.0.3  “¡“√∂„™âß“π¿“…“‰∑¬‰¥âÕ¬à“ß ¡∫Ÿ√≥å  à«π‡«Õ√å™—Ëπ CS, CS2 ·⋲– CS3
„™â‰¥â°—∫‡©æ“–øÕπµå Unicode ‡∑à“π—Èπ ‰¡à “¡“√∂„™â°—∫øÕπµå‡°à“®“° Mac OS 9 ‰¥â
- Adobe Photoshop 7.0.1  “¡“√∂„™âß“π¿“…“‰∑¬‰¥âÕ¬à“ß ¡∫Ÿ√≥å (¬°‡«âπ‡§√◊ËÕß·¡§∑’Ëµ‘¥µ—Èß Mac OS X 10.5.x
À√◊Õ Ÿß°«à“ ‡π◊ËÕß®“° Adobe Photoshop 7.0.x ‰¡à “¡“√∂∑”ß“π‰¥â)  à«π‡«Õ√å™—Ëπ CS, CS2 ·⋲– CS3
„™â‰¥â°—∫‡©æ“–øÕπµå Unicode ‡∑à“π—Èπ ‰¡à “¡“√∂„™â°—∫øÕπµå‡°à“®“° Mac OS 9 ‰¥â
- Microsoft Word ·⋲– Microsoft Excel ‰¡à “¡“√∂„™âß“π¿“…“‰∑¬‰¥â

§”·π–π” ”À√—∫°“√µ—Èß§à“ Justification „π Adobe InDesign
- ‡æ◊ËÕ§«“¡ «¬ß“¡„π°“√„™âß“π¿“…“‰∑¬°—∫ Thai Composer „π Adobe InDesign ·π–π”„Àâµ—Èß§à“µà“ßÊ
¥—ß¿“æ¢â“ß⋲à“ßπ’È (‡ªî¥«‘π‚¥«å Justification ‚¥¬°“√°¥·ªÑπ shift-option-command-J À√◊Õ‰ª∑’Ë‡¡πŸ Window-
>Type & Tables->Paragraph ‡æ◊ËÕ‡ªî¥æ“‡⋲µµå Paragraph ·⋲â«§⋲‘°∑’ËªÿÉ¡ “¡‡À⋲’Ë¬¡∑’ËÕ¬Ÿàµ√ß¡ÿ¡∫π¢«“¢Õßæ“
‡⋲µµå®–ª√“°Ø‡¡πŸ¢÷Èπ¡“ „Àâ‡⋲◊Õ°À—«¢âÕ Justification...)

°“√µ—Èß§à“·ªÑπæ‘¡æå¢Õß TSP
1. ‡ªî¥ System Preferences
2. ‡⋲◊Õ° TSP ‰ª∑’ËÀ—«¢âÕ Keyboard
3. ‡⋲◊Õ°µ—«‡⋲◊Õ°∑’ËµâÕß°“√ ´÷Ëß¡’√“¬°“√µàà“ßÊ „Àâ‡⋲◊Õ°¥—ßπ’È

- Check for illegal sequence of characters ‡ªìπ°“√µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå¿“…“‰∑¬
´÷Ëß¡’°“√µ√«® Õ∫„π 2 √Ÿª·∫∫§◊Õ Simple mode ·⋲– Strict mode

°“√µ√«® Õ∫·∫∫ Simple mode ®–‡ªìπ°“√µ√«® Õ∫¢—Èπµâπ ‡æ◊ËÕªÑÕß°—π‰¡à„Àâ¡’°“√æ‘¡æåµ—«Õ—°…√´È”°—π‚¥¬
‰¡àµ—Èß„® ¡—°‡°‘¥°—∫«√√≥¬ÿ°µåÀ√◊Õ √–∑’Ë«“ßµ”·Àπàß∫πÀ√◊Õ⋲à“ß¢Õßæ¬—≠™π– ‡π◊ËÕß®“°Õ—°…√‡À⋲à“π’È®–ª√“°Ø´âÕπ
∑—∫°—π®÷ß‰¡à “¡“√∂¡Õß‡ÀÁπ§«“¡º‘¥æ⋲“¥‰¥â ‡™àπ æ‘¡æå‰¡â‡Õ° 2 µ—«´È”°—π ‡ªìπµâπ



°“√µ√«® Õ∫·∫∫ Strict mode πÕ°®“°®–ªÑÕß°—π°“√æ‘¡æåµ—«Õ—°…√´âÕπ∑—∫°—π‡À¡◊Õπ Simple mode ·⋲â«
¬—ß‡ªìπ°“√µ√«® Õ∫µ—« –°¥„π¢—Èπµâπ ‡æ◊ËÕªÑÕß°—π‰¡à„Àâæ‘¡æå¢âÕ§«“¡∑’Ë‰¡à “¡“√∂‡ªìπ‰ª‰¥â„π¿“…“‰∑¬ ‡™àπ
æ‘¡æå √–‡Õ·⋲â«µ“¡¥â«¬ √–Õ“‚¥¬‰¡à¡’æ¬—≠™π–§—Ëπ ‡ªìπµâπ

- Correct sequence of tone marks and vowels ‡√’¬ß⋲”¥—∫°“√æ‘¡æå √–·⋲–«√√≥¬ÿ°µå„Àâ∂Ÿ°µâÕß‚¥¬Õ—µ‚π¡—µ‘ ‡™àπ
∂â“¡’°“√æ‘¡æå‰¡â‡Õ°·⋲â«µ“¡¥â«¬‰¡âÀ—πÕ“°“» °Á®–®—¥‡√’¬ß„Àâ„À¡à‡ªìπ‰¡âÀ—πÕ“°“»·⋲â«‰¡—‡Õ° ‡ªìπµâπ

°“√„™â TSP °—∫ Adobe Photoshop CS2
- ∂â“‰¡àª√“°ØøÕπµå‰∑¬∫π‡¡πŸ∑—ÈßÊ ∑’Ë¡’øÕπµå‰∑¬Õ¬Ÿà„π‚ø⋲‡¥Õ√å Fonts ¢Õß System „Àâ quit ÕÕ°®“°‚ª√·°√¡
·⋲â«√—π„À¡àÕ’°§√—Èß®–ª√“°ØøÕπµå‰∑¬Õ¬à“ß∂Ÿ°µâÕß

°“√„™â TSP °—∫ Adobe Illustrator CS
- ‰¡à “¡“√∂„™â‰¥â°—∫øÕπµå‰∑¬ 5 øÕπµå∑’Ë¡“°—∫ Mac OS X §◊Õ Ayuthaya, Krungthep, Sathu, Silom, Thonburi
‡π◊ËÕß®“°∑—Èß 5 øÕπµåπ’È®–‰¡à¡’°“√ª√—∫√–¥—∫ √–·⋲–«√√≥¬ÿ°µå„Àâ∂Ÿ°µâÕß

- °“√·°â‰¢ªí≠À“°“√· ¥ß¿“…“‰∑¬‰¡à∂Ÿ°µâÕß‡¡◊ËÕ‡ªî¥‰ø⋲å Adobe Illustrator 10.x À√◊ÕµË”°«à“ À√◊Õ copy
¢âÕ§«“¡¿“…“‰∑¬®“°‚ª√·°√¡∫“ß‚ª√·°√¡„π Classic environment ¡“ paste „π Adobe Illustrator CS
„Àâ∑”µ“¡¢—ÈπµÕπµàÕ‰ªπ’È
1. ‡⋲◊Õ°‡§√◊ËÕß¡◊Õ T  ”À√—∫·°â‰¢¢âÕ§«“¡
2. §⋲‘°∑’Ë¢âÕ§«“¡·⋲â«‡⋲◊Õ°™à«ß¢âÕ§«“¡∑’ËµâÕß°“√·°â‰¢ (°“√‡⋲◊Õ°™à«ß¢âÕ§«“¡®–„™â§” —Ëß Edit->Select All
‡æ◊ËÕ‡⋲◊Õ°¢âÕ§«“¡∑—ÈßÀ¡¥°Á‰¥â)
3. ‡√’¬°§” —Ëß·°â‰¢®“°‡¡πŸ Type->TSP->Update Text ¢âÕ§«“¡∑’Ë‡⋲◊Õ°‰«â®–∂Ÿ°·°â‰¢‚¥¬Õ—µ‚π¡—µ‘
4.  “¡“√∂¬°‡⋲‘°°“√·°â‰¢‰¥â‚¥¬°“√‡√’¬°§” —Ëß Edit->Undo

- À⋲—ß®“°µ‘¥µ—Èß TSP ∂â“ Adobe Illustrator CS ‰¡à “¡“√∂√—π‰¥â „Àâ°¥·ªÑπ command-option-shift §â“ß‰«â·⋲â«√—π
Adobe Illustrator CS Õ’°§√—Èß ‚ª√·°√¡®–¡’«‘π‚¥«å¢÷Èàπ¡“∂“¡«à“®–⋲∫‚ø⋲‡¥Õ√å Adobe Illustrator Setting À√◊Õ‰¡à
(Do you want to delete the Adobe Illustrator Settings folder?) „ÀâµÕ∫ OK ®–∑”ß“π‰¥âµ“¡ª°µ‘

°“√„™â TSP °—∫ Adobe Photoshop CS
- ‰¡à “¡“√∂„™â‰¥â°—∫øÕπµå‰∑¬ 5 øÕπµå∑’Ë¡“°—∫ Mac OS X §◊Õ Ayuthaya, Krungthep, Sathu, Silom, Thonburi
‡π◊ËÕß®“°∑—Èß 5 øÕπµåπ’È®–‰¡à¡’°“√ª√—∫√–¥—∫ √–·⋲–«√√≥¬ÿ°µå„Àâ∂Ÿ°µâÕß

- °“√‡ªî¥‰ø⋲å‡Õ° “√®“° Adobe Photoshop 6.x ·⋲– 7.x „π Adobe Photoshop CS ‡¡◊ËÕ‡ªî¥‰ø⋲å®–
¡’¢âÕ§«“¡‡µ◊Õπ®“° Photoshop „Àâ∑”°“√Õ—æ‡¥∑ text layer ¥—ßπ’È "Some text layers might need to be updated
before they can be used for vector base output.  Do you want to update these layers now?"  ®–µâÕß‡⋲◊Õ°
Update ‡∑à“π—Èπ ∂â“‰¡àÕ—æ‡¥∑®–∑”„Àâ¢âÕ§«“¡¿“…“‰∑¬· ¥ßº⋲‰¡à∂Ÿ°µâÕß



- °“√„™â‰ø⋲å‡Õ° “√∫π Mac OS X ∫“ß§√—ÈßÕ“®¡’ªí≠À“‡√◊ËÕß permission °“√‡ªî¥‰ø⋲å‡Õ° “√®“° Adobe
Photoshop 6.x ·⋲– 7.x „π Adobe Photoshop CS ∂â“¡’¢âÕ§«“¡‡µ◊Õπ¥—ßπ’È "File '™◊ËÕ‰ø⋲å' is locked.  Use the 'Get
Info' command in the Finder to change its permission to Read & Write and reopen it again, otherwise Thai
contents will display incorrectly."  „Àâªî¥‰ø⋲å ·⋲â«‰ª∑’Ë Finder §⋲‘°‡⋲◊Õ°‰Õ§Õπ¢Õß‰ø⋲åπ—Èπ ·⋲â«„™â§” —Ëß Get
Info ®“°‡¡πŸ File À√◊Õ°¥·ªÑπ command-I ‡æ◊ËÕ‡ªî¥«‘π‚¥«å Info ·⋲â«‡ª⋲’Ë¬π permission „Àâ‡ªìπ Read & Write
·⋲â«‡ªî¥‰ø⋲åπ—Èπ„π Photoshop Õ’°§√—Èß

- °“√‡ªî¥‰ø⋲å‡Õ° “√®“° Adobe Photoshop 6.x ·⋲– 7.x ∑’Ë¡’¢π“¥„À≠à ®–„™â‡«⋲“π“π°«à“ª°µ‘ ‡π◊ËÕß®“° TSP
µâÕß∑”°“√·ª⋲ß¢âÕ§«“¡®“°‡«Õ√å™—Ëπ‡°à“„Àâ “¡“√∂„™â„π‡«Õ√å™—Ëπ CS ‰¥âÕ¬à“ß∂Ÿ°µâÕß ‡¡◊ËÕ‡ªî¥‡ √Á®·⋲â«„Àâ∫—π∑÷°
‡ªìπ‡«Õ√å™—Ëπ CS ®–‰¡à‡®Õªí≠À“π’ÈÕ’°

°“√„™â TSP °—∫ Adobe InDesign CS ·⋲– 2.0.2
- °“√„™â¿“…“‰∑¬„π Adobe InDesign ®–µâÕßµ—Èß§à“ Paragraph „Àâ‡√’¬°„™â Thai Composer °àÕπ ∑”‰¥â‚¥¬‰ª
∑’Ëæ“‡⋲µµå Paragraph (‡¡πŸ Window->Type & Tables->Paragraph) ·⋲â«§⋲‘°∑’ËªÿÉ¡ “¡‡À⋲’Ë¬¡∑’ËÕ¬Ÿà
µ√ß¡ÿ¡∫π¢«“¢Õßæ“‡⋲µµå®–ª√“°Ø‡¡πŸ¢÷Èπ¡“ „Àâ‡⋲◊Õ°À—«¢âÕ Thai Composer (®–µâÕß¡’‡§√◊ËÕßÀ¡“¬∂Ÿ°Õ¬ŸàÀπâ“¢âÕ)

- °“√µ—Èß§à“ Thai Composer ¢≥–∑’Ë∑”ß“πÕ¬Ÿà„π‡Õ° “√„¥ ®–¡’º⋲‡©æ“–°—∫‡Õ° “√π—Èπ ∂â“µâÕß°“√„Àâ¡’º⋲
°—∫∑ÿ°‡Õ° “√ ®–µâÕßªî¥‡Õ° “√∑’Ë‡ªî¥‰«â∑—ÈßÀ¡¥°àÕπ ·⋲â«®÷ßµ—Èß§à“µ“¡¢—ÈπµÕπ¢â“ßµâπ

- ·¡â®–µ—Èß§à“„Àâ‡√’¬°„™â Thai Composer ·µà Thai Composer ®–‡√‘Ë¡µâπ∑”ß“π‡¡◊ËÕ¡’°“√·°â‰¢¢âÕ§«“¡„π‡Õ° “√
¥—ßπ—Èπ‡¡◊ËÕ‡ªî¥‚ª√·°√¡ InDesign „πµÕπ·√°Õ“®®–¬—ß‰¡à‡ÀÁπ‰Õ§Õπ¢Õß TSP ª√“°ØÕ¬Ÿà∫π Dock

°“√„™â TSP °—∫ Microsoft Word 10.1.5
- °“√æ‘¡æå smart quote ∑—Èß·∫∫‡¥’Ë¬«·⋲–·∫∫§Ÿà®–¡’º⋲„Àâµ”·Àπàß¢Õß‡§Õ√å‡´Õ√å„π∫√√∑—¥π—ÈπÕ¬Ÿàº‘¥µ”·Àπàß §«√
ªî¥§«“¡ “¡“√∂¢Õß Microsoft Word „π°“√ª√—∫ smart quote ‚¥¬Õ—µ‚π¡—µ‘„π¢≥–∑’Ëæ‘¡æå ‚¥¬‰ª∑’Ë‡¡πŸ
Tools/AutoCorrect ®“°π—Èπ‰ª∑’Ë·∑Á∫ AutoFormat As You Type ·⋲â«§⋲‘°¬°‡⋲‘°À—«¢âÕ "Straight quotes" with
"smart quotes" (®–µâÕß‰¡à¡’‡§√◊ËÕßÀ¡“¬∂Ÿ°Õ¬ŸàÀπâ“¢âÕ)

- „π°√≥’∑’ËµâÕß°“√æ‘¡æå smart quote „Àâ„™â·ªÑπæ‘¡æå√à«¡°—∫°“√°¥·ªÑπ shift ·⋲– option §◊Õ option-[ ·⋲– shift-
option-[  ”À√—∫æ‘¡æå smart quote ·∫∫§Ÿà option-] ·⋲– shift-option-]  ”À√—∫æ‘¡æå smart quote ·∫∫‡¥’Ë¬«

- „π∫√√∑—¥∑’Ë¡’ smart quote ·⋲–À⋲—ß®“°π—Èπ¡’°“√‡§“–·ªÑπ space ®–¡’º⋲„Àâ¢âÕ§«“¡„π∫√√∑—¥π—Èπ· ¥ßº⋲º‘¥
µ”·Àπàß §◊Õ®–¡’µ—«Õ—°…√∫“ßµ—«´âÕπ∑—∫°—π „Àâ·°â‰¢‚¥¬°“√‰ª∑’Ë‡¡πŸ Word/Preference ®“°π—Èπ‰ª∑’Ë à«π¢Õß
Spelling and Grammar ·⋲â«§⋲‘°¬°‡⋲‘° Check spelling as you type ¿“¬„µâÀ—«¢âÕ Spelling
(®–µâÕß‰¡à¡’‡§√◊ËÕßÀ¡“¬∂Ÿ°Õ¬ŸàÀπâ“¢âÕ)



°“√„™â TSP „π Classic environment (µâÕßµ‘¥µ—Èß TSP 4.7 for OS 9)
- ∂â“¡’°“√‡ª⋲’Ë¬π System Folder  ”À√—∫ Classic environment ·⋲â«‰¡à “¡“√∂µ√«® Õ∫Œ“√å¥⋲ÁÕ°„π
‚ª√·°√¡ª√–‡¿∑ Classic ‰¥â „Àâµ‘¥µ—Èß TSP for OS X Õ’°§√—Èß

°“√„™â TSP °—∫ iTunes 4.7
- µ—Èß·µà TSP 7.0 ‡ªìπµâπ‰ª ®–‰¡à√Õß√—∫°“√„™âß“π„π iTunes 4.7 Õ’°µàÕ‰ª À“°µâÕß°“√„™âß“π¿“…“‰∑¬„π iTunes
‚ª√¥µ‘¥µ—Èß‚ª√·°√¡ ThaiTunesÓ (√Õß√—∫ iTunes 7.0 ¢÷Èπ‰ª)

°“√ª√—∫ª√ÿß·°â‰¢„π‡«Õ√å™—Ëπ°àÕπ
20  ‘ßÀ“§¡ 2550
‡«Õ√å™—Ëπ 7.0

- ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe InDesign CS3
- ·°â‰¢ Adobe InDesign „Àâ “¡“√∂„™âß“π°—∫ user ∏√√¡¥“‰¥â (‰¡à®”‡ªìπµâÕß‡ªìπ user ∑’Ë‡ªìπ admin
‡À¡◊Õπ‡«Õ√å™—Ëπ°àÕπÀπâ“π’È) ∑”„Àâ “¡“√∂„™â„π√–∫∫ multi-user ‰¥â (‚ª√·°√¡Õ◊ËπÊ  “¡“√∂„™â„π√–∫∫ multi-user
‰¥âÕ¬Ÿà·⋲â«)

20 ¡’π“§¡ 2549
‡«Õ√å™—Ëπ 6.1

- ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe Illustrator CS2 ∑—Èß‡«Õ√å™—Ëπ 12.0 ·⋲– 12.0.1
- ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe InDesign CS2 ∑—Èß‡«Õ√å™—Ëπ 4.0 ·⋲– 4.0.2
- ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe Photoshop CS2 ‡«Õ√å™—Ëπ 9.0

16 °ÿ¡¿“æ—π∏å 2549
‡«Õ√å™—Ëπ 6.0

- ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe Illustrator CS2, Adobe InDesign CS2 ·⋲– Adobe Photoshop CS2
- „™â‰¥â°—∫øÕπµå unicode  ”À√—∫ Mac OS X, øÕπµå‡°à“®“° Mac OS 9 ·⋲–øÕπµå®“° Windows
´÷Ëß∑ÿ°øÕπµå “¡“√∂æ‘¡æå‰∑¬·⋲–ª√—∫√–¥—∫ √–«√√≥¬ÿ°µå‰¥âÕ¬à“ß∂Ÿ°µâÕß
- Adobe InDesign CS2  “¡“√∂„™âß“π‰¥â∑—Èß∫π‡§√◊ËÕß∑’Ë„™â™‘ª PowerPC ·⋲–™‘ª Intel  “¡“√∂„™âß“π¿“…“
‰∑¬·⋲–µ—¥§”‰∑¬‰¥âÕ¬à“ß∂Ÿ°µâÕß



13 ¡‘∂ÿπ“¬π 2548
‡«Õ√å™—Ëπ 5.9

Adobe Illustrator CS
Adobe Photoshop CS
- ·°âªí≠À“°“√‰¡à “¡“√∂„™âß“π∫π‡§√◊ËÕß∑’Ë„™â Mac OS X 10.3.x (Panther) À√◊ÕµË”°«à“

Microsoft Office X
- ·°â‰¢°“√‰¡à‡ÀÁπøÕπµå‰∑¬„π Microsoft Word ·⋲– Microsoft Excel

18 æƒ…¿“§¡ 2548
‡«Õ√å™—Ëπ 5.8

Microsoft Office X
- ·°â‰¢°“√‰¡à‡ÀÁπøÕπµå‰∑¬∫“ßµ—«„π Microsoft Word ·⋲– Microsoft Excel

5 ‡¡…“¬π 2548
‡«Õ√å™—Ëπ 5.7

Thai Support Plugin
- √Õß√—∫°“√∑”ß“π ”À√—∫ Mac OS X 10.4 (Tiger)
- ª√—∫ª√ÿß°“√∑”ß“π¢Õßª⋲—È°Õ‘π·µà⋲–µ—«„Àâ∑”ß“π‰¥â√«¥‡√Á«¬‘Ëß¢÷Èπ
- TSP „π System Preferences  “¡“√∂µ—Èß§à“°“√∑”ß“π¢Õß·ªÑπæ‘¡æå∑’Ë„™â„π Thai Support Plugin ‰¥â
- ·°â‰¢ iTunes „Àâ “¡“√∂· ¥ß™◊ËÕ¿“…“‰∑¬‰¥âÕ¬à“ß∂Ÿ°µâÕß

Adobe Illustrator CS
- ·°âªí≠À“‡¡◊ËÕæ‘¡æå Ω ·⋲â«°⋲“¬‡ªìπ ¡ „πøÕπµå∫“ßøÕπµå
- ‡¡πŸ Type/TSP/Update Text  ”À√—∫·°â‰¢¢âÕ§«“¡¿“…“‰∑¬„π‡Õ° “√∑’Ë √â“ß®“° Adobe Illustrator 10.x
À√◊ÕµË”°«à“ À√◊Õ¢âÕ§«“¡∑’Ë copy ¡“ paste ®“°·Õæ⋲‘‡§™—Ëπ∑’Ë∑”ß“π„π classic environment ‡™àπ SimpleText
„π‡«Õ√å™—Ëππ’È “¡“√∂‡⋲◊Õ°¢âÕ§«“¡∑ÿ°™‘Èπ·⋲â«Õ—æ‡¥∑‰¥â¿“¬„π§√—Èß‡¥’¬« ‰¡à®”‡ªìπµâÕß‡⋲◊Õ°¢âÕ§«“¡·⋲–Õ—æ‡¥∑∑’⋲–
™‘ÈπÕ’°µàÕ‰ª

Adobe InDesign CS
- ·°âªí≠À“°“√µ‘¥µ—Èßª⋲—È°Õ‘π TSP InDesign „π‚ø⋲‡¥Õ√å Plug-ins ¢Õß Adobe InDesign CS
- µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå ªÑÕß°—π°“√æ‘¡æå √–·⋲–«√√≥¬ÿ°µåÀ⋲“¬µ—«´È”°—π
-  “¡“√∂æ‘¡æåÕ—°¢√–æ‘‡»…¥â«¬øÕπµå¿“…“Õ—ß°ƒ…‰¥â
- ·°âªí≠À“‡¡◊ËÕ‡ªî¥‡Õ° “√∑’Ë¡’°“√®—¥¬àÕÀπâ“·⋲â«· ¥ßº⋲‰¡à∂Ÿ°µâÕß



Adobe Photoshop CS
- ·°âªí≠À“‡¡◊ËÕæ‘¡æå Ω ·⋲â«°⋲“¬‡ªìπ ¡ „πøÕπµå∫“ßøÕπµå
- ·°âªí≠À“°“√‡ªî¥‰ø⋲å‡Õ° “√®“° Adobe Photoshop 6.x ·⋲– 7.x ∑’Ë„™â‡«⋲“π“π¡“° „π
‡«Õ√å™—Ëππ’È “¡“√∂‡ªî¥‰¥âÕ¬à“ß√«¥‡√Á«

iTunes
-  “¡“√∂· ¥ß™◊ËÕ¿“…“‰∑¬‰¥âÕ¬à“ß∂Ÿ°µâÕß ∑—Èß„π à«π¢Õß™◊ËÕ‡æ⋲ß ™◊ËÕ»‘⋲ªîπ ™◊ËÕÕ—⋲∫—È¡ ‡ªìπµâπ

9 ∏—π«“§¡ 2547
‡«Õ√å™—Ëπ 5.6

1. ·°â‰¢ªí≠À“‡¡◊ËÕæ‘¡æå Æ À√◊Õ Ø ·⋲â«µ“¡¥â«¬ √–Õ“ µ—« “ ®–°⋲“¬‡ªìπ⋲“°¢â“ß¬“« ( √–Õ“À“ß¬“«) ‡™àπ
°√°Æ“§¡ „π Adobe Illustrator CS, Adobe Photoshop CS ·⋲– Word
2. ·°â‰¢ªí≠À“‡¡◊ËÕæ‘¡æå Æ À√◊Õ Ø ·⋲â«µ“¡¥â«¬ √–Õÿ À√◊Õ √–ÕŸ À√◊Õæ‘π∑ÿ µ”·Àπàß √–®–´âÕπ∑—∫°—∫µ—«Õ—°…√„π
Adobe Photoshop CS
3. ·°â‰¢ªí≠À“‡¡◊ËÕæ‘¡æå ª À√◊Õ Ω À√◊Õ ø µ“¡¥â«¬ √–ÕÿÀ√◊Õ √–ÕŸ ·⋲â«µ“¡¥â«¬«√√≥¬ÿ°µå ‡™àπ ªÿÉ¡ ΩÿÉπ øÿÑß
µ”·Àπàß«√√≥¬ÿ°µå®–· ¥ßº‘¥µ”·Àπàß„π Adobe Illustrator CS
4. ·°â‰¢ªí≠À“‡¡◊ËÕæ‘¡æå ≠ ·⋲â«µ“¡¥â«¬ √–Õÿ À√◊Õ √–ÕŸ À√◊Õæ‘π∑ÿ ¥â«¬øÕπµå¬Ÿπ‘‘‚§â¥À√◊ÕøÕπµå®“°«‘π‚¥« å ·⋲â«
µ”·Àπàß √–®–´âÕπ∑—∫°Ì∫µ—«Õ—°…√„π Adobe InDesign CS
5. ª√—∫ª√ÿß„Àâ Adobe Illustrator CS ·⋲– Adobe Photoshop CS  “¡“√∂„™âøÕπµå®“°«‘π‚¥« å (æ’´’)
‚¥¬ª√—∫µ”·Àπàß √–·⋲–«√√≥¬ÿ°µå„ÀâÕ¬à“ß∂Ÿ°µâÕß
6. µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå„π Adobe Illustrator CS ·⋲– Adobe Photoshop CS ªÑÕß°—π°“√æ‘¡æå
 √–·⋲–«√√≥¬ÿ°µåÀ⋲“¬µ—«´È”°—π

18 æƒ»®‘°“¬π 2547
‡«Õ√å™—Ëπ 5.5

1. ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe InDesign CS (Õà“π√“¬⋲–‡Õ’¬¥„π‰ø⋲å TSP for InDesign.rtf)
2. ·°â‰¢ªí≠À“„π Adobe InDesign 2.0.2 ∑’Ë‡¡◊ËÕ°¥·ªÑπ tab ·⋲â«∑”„Àâ‚ª√·°√¡ªî¥µ—«‡Õß„π∫“ß§√—Èß
3. ·°â‰¢ªí≠À“°“√‰¡à “¡“√∂æ‘¡æå —≠⋲—°…≥å∫“ßµ—«¥â«¬·ªÑπæ‘¡æåª°µ‘·⋲–·ªÑπæ‘¡æå∑’Ë„™â√à«¡°—∫·ªÑπ option
¥â«¬øÕπµå¿“…“Õ—ß°ƒ…„π Adobe Illustrator CS ·⋲– Adobe Photoshop CS
4. ·°â‰¢ªí≠À“‡¡◊ËÕ‡ªî¥‰ø⋲å Adobe Illustrator 10.x À√◊ÕµË”°«à“ „π Adobe Illustrator CS À√◊Õ copy
¢âÕ§«“¡¿“…“‰∑¬®“°‚ª√·°√¡∫“ß‚ª√·°√¡„π Classic environment ¡“ paste „π Adobe Illustrator CS
·⋲â«· ¥ßº⋲‰¡à∂Ÿ°µâÕß
5. ·°â‰¢ªí≠À“°“√µ‘¥µ—Èß TSP „π‡§√◊ËÕß∑’Ë‰¡à¡’ Classic environment
6. ‡æ‘Ë¡§”«à“ TSP ∫π‰Õ§Õπ¢Õß‚ª√·°√¡∑’Ë°”⋲—ß‡ªî¥„™âß“π∑’Ëª√“°ØÕ¬Ÿà∫π Dock ‡æ◊ËÕ· ¥ß„Àâ∑√“∫«à“ TSP



°”⋲—ß∑”ß“π°—∫‚ª√·°√¡π—Èπ
7. ‡æ‘Ë¡ TSP „π Systen Preferences  ”À√—∫‡ªî¥ªî¥°“√∑”ß“π¢Õß TSP

  
23 °√°Æ“§¡ 2547
‡«Õ√å™—Ëπ 5.3

1. ·°â‰¢ªí≠À“°“√‰¡à “¡“√∂æ‘¡æå "Ω" ¥â«¬øÕπµå∫“ßøÕπµå„π‚ª√·°√¡ Adobe Illustrator CS ·⋲– Adobe
Photoshop CS
2. ·°â‰¢„Àâ “¡“√∂‡ªî¥‰ø⋲å‡Õ° “√∑’Ë¡’¢âÕ§«“¡¿“…“‰∑¬®“°‚ª√·°√¡ Adobe Photoshop 6.x ·⋲– 7.x „π Adobe
Photoshop CS ‰¥â

25 ¡‘∂ÿπ“¬π 2547
‡«Õ√å™—Ëπ 5.2

1. ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫‚ª√·°√¡ Adobe Illustrator CS ·⋲– Adobe Photoshop CS ‚¥¬¡’§«“¡ “¡“√∂¥—ßπ’È
- „™â·ªÑπæ‘¡æå‰∑¬∑’Ë¡“°—∫´◊ ‡∑Á¡æ‘¡æå¢âÕ§«“¡¿“…“‰∑¬‰¥âÕ¬à“ß∂Ÿ°µâÕß
- ª√—∫√–¥—∫ √–·⋲–«√√≥å¬ÿ°µå„Àâ∂Ÿ°µâÕß‚¥¬Õ—µ‚π¡—µ‘
- · ¥ß‡§√◊ËÕßÀ¡“¬§”æŸ¥·∫∫‚§âß (smart quotes) ∑—Èß·∫∫‡¥’Ë¬«·⋲–·∫∫§Ÿà„Àâ‚¥¬Õ—µ‚π¡—µ‘
- „™â°—∫øÕπµå‡°à“®“° Mac OS 9 ‰¥â∑ÿ°øÕπµå

14 ¡‘∂ÿπ“¬π 2547
‡«Õ√å™—Ëπ 5.1

1. „™âß“π‰¥â°—∫‚ª√·°√¡ Microsoft Excel 10.1.5  “¡“√∂æ‘¡æå¢âÕ§«“¡¿“…“‰∑¬·⋲–ª√—∫√–¥—∫ √–«√√≥¬ÿ°µå
„Àâ∂Ÿ°µâÕß ∑—Èß„π‡´⋲⋲å øÕ√å¡Ÿ⋲“∫“√å ·⋲– “¡“√∂µ—Èß™◊ËÕ™’µ‡ªìπ¿“…“‰∑¬‰¥â

5 æƒ…¿“§¡ 2547
‡«Õ√å™—Ëπ 5.0

1. „™âß“π‰¥â°—∫‚ª√·°√¡ Microsoft Word 10.1.5  “¡“√∂æ‘¡æå¢âÕ§«“¡¿“…“‰∑¬ µ—¥§”‰∑¬‰¥â∂Ÿ°µâÕß ·⋲–
ª√—∫√–¥—∫ √–«√√≥¬ÿ°µå„Àâ∂Ÿ°µâÕß‚¥¬Õ—µ‚π¡—µ‘∑—Èß∫πÀπâ“®Õ·⋲–ÕÕ°‡§√◊ËÕßæ‘¡æå
2. ·°â‰¢°“√„™â·ªÑπæ‘¡æå‰∑¬„π Adobe Illustrator Adobe InDesign ·⋲– Adobe Photoshop „Àâ “¡“√∂°¥·ªÑπ
option À√◊Õ option-shift √à«¡°—∫·ªÑπµ—«Õ—°…√‡æ◊ËÕæ‘¡æåÕ—°¢√æ‘‡»…‰¥âÕ¬à“ß∂Ÿ°µâÕß ‡™àπ ™ © ® « » • …
3. ·°â‰¢°“√‰¡à “¡“√∂µ√«® Õ∫Œ“√å¥⋲ÁÕ°„π Classic environment „π°√≥’∑’Ë¡’ System Folder  ”À√—∫ Classic
Õ¬ŸàÀ⋲“¬∑’Ë À√◊ÕÕ¬Ÿà§π⋲–æ“√å∑‘™—Ëπ°—∫ System ¢Õß‚Õ‡Õ ‡∑Áπ



19 ∏—π«“§¡ 2546
‡«Õ√å™—Ëπ 4.7

1. ·°â‰¢„Àâ„™âß“π‰¥â°—∫‚ª√·°√¡ Classic „π Classic Environment ∫π Mac OS X 10.3 (Panther)

19 æƒ»®‘°“¬π 2546
‡«Õ√å™—Ëπ 4.6

1. ª√—∫ª√ÿß„Àâ “¡“√∂„™âß“π‰¥â°—∫ Adobe Illustrator Adobe InDesign ·⋲– Adobe Photoshop ∑’Ë∑”ß“π∫π Mac
OS X 10.3 (Panther)

24 °—π¬“¬π 2546
‡«Õ√å™—Ëπ 4.5

1. ·°âªí≠À“°“√‰¡à “¡“√∂µ√«® Õ∫Œ“√å¥⋲ÁÕ°„π Classic environment ∫π‡§√◊ËÕß‡æ“‡«Õ√å·¡§®’ 5 ·⋲–‡§√◊ËÕß
√ÿàπÕ◊Ëπ∫“ß‡§√◊ËÕß

3 °—π¬“¬π 2546
‡«Õ√å™—Ëπ 4.4

1. ·°âªí≠À“°“√‰¡à “¡“√∂µ√«® Õ∫Œ“√å¥⋲ÁÕ°„π Classic environment ∫π‡§√◊ËÕß·¡§Õ‘π∑Õ™∫“ß‡§√◊ËÕß

26  ‘ßÀ“§¡ 2546
‡«Õ√å™—Ëπ 4.3

Adobe Photoshop
1. ª√—∫ª√ÿß„Àâ “¡“√∂· ¥ß™◊ËÕ‡⋲‡¬Õ√å‡ªìπ¿“…“‰∑¬‰¥âÕ¬à“ß∂Ÿ°µâÕß
2. ·°â‰¢ªí≠À“‡¡◊ËÕªî¥‚ª√·°√¡„π¢≥–∑’Ë‡ªî¥«‘π‚¥«åß“π§â“ß‰«â®–¡’¢âÕ§«“¡· ¥ß§«“¡º‘¥æ⋲“¥¢÷Èπ¡“·®âß‡µ◊Õπ „π
‡«Õ√å™—Ëππ’È®–‰¡à¡’·⋲â«
3. ·°â‰¢ª√—∫ª√ÿß°“√µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå·⋲–°“√ª√—∫µ”·Àπàß √–«√√≥¬ÿ°µå„Àâ¡’§«“¡ ¡∫Ÿ√≥å¬‘Ëß¢÷Èπ

Adobe Illustrator
1. ‡¡◊ËÕ‡ªî¥‡Õ° “√¢Õß Adobe Illustrator ∑’Ë¬—ß‰¡à‰¥â∑”°“√ª√—∫µ”·Àπàß √–·⋲–«√√≥¬ÿ°µå„Àâ∂Ÿ°µâÕß¡“°àÕπ



‡¡◊ËÕ§⋲‘°‡¡â“ å∑’Ëµ”·Àπàß¢âÕ§«“¡°Á®–∑”°“√ª√—∫„Àâ∂Ÿ°µâÕß‚¥¬Õ—µ‚π¡—µ‘
2. ·°â‰¢ª√—∫ª√ÿß°“√µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå·⋲–°“√ª√—∫µ”·Àπàß √–«√√≥¬ÿ°µå„Àâ¡’§«“¡ ¡∫Ÿ√≥å¬‘Ëß¢÷Èπ

Adobe InDesign
1. ·°â‰¢ª√—∫ª√ÿß°“√µ√«® Õ∫⋲”¥—∫°“√°¥·ªÑπæ‘¡æå·⋲–°“√ª√—∫µ”·Àπàß √–«√√≥¬ÿ°µå„Àâ¡’§«“¡ ¡∫Ÿ√≥å¬‘Ëß¢÷Èπ

1  ‘ßÀ“§¡ 2546
‡«Õ√å™—Ëπ 4.2

1. ª√—∫ª√ÿß„Àâ„™âß“π‰¥â°—∫ Adobe InDesign 2.0.2 ·⋲– Adobe Photoshop 7.0.1

9 ¡‘∂ÿπ“¬π 2546
‡«Õ√å™—Ëπ 4.1

1. ·°â‰¢ª⋲—Í°Õ‘π Thai Illustrator X  ”À√—∫ Adobe Illustrator 10.x ∑’Ë—√—π„π Mac OS X „Àâ∑”ß“π‡¢â“°—π‰¥â°—∫
‡«Õ√å™—Ëπ∑’Ë√—π„π Mac OS 9

8 æƒ…¿“§¡ 2546
‡«Õ√å™—Ëπ 4.0

1. „™âß“π‰¥â°—∫ Adobe Illustrator 10, 10.0.1, ·⋲– 10.0.3 ∫π Mac OS X


